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1. Introduction
With the Capture Tool, you can perform scans and view the captured images.
Important: the scanner must be connected to your computer to start the Capture Tool.
On a Windows PC:
1. Start the Capture Tool from Start>All Programs>IRIS IRIScan Pro 5 Scanner.
2. Select your driver type and scanner model and click OK. The Capture Tool dialog box will be displayed.
On a Mac computer:
1. Click the Capture Tool icon on the Desktop.

Note: the IRIScan Pro 5 File and IRIScan Pro 5 Invoice are not available on Mac.
Interface
Fit Page

Setup

Scan

File Format

Save

Actual Size

File Path

1.

Choose your desired file format from the File Format drop down list box. The choices include JPEG,
TIFF, MTIFF, PDF, MPDF, GIF, and BMP. The supported file formats vary depending on your scanner
model.

2.

Type your desired folder name and file name in the File Path box.

3.

Click the Setup button (
dialog box.

) or choose Setup from the File menu to prompt the Scanner Properties

Image
Selection
Box

4.

From the Image Selection Box, choose your desired image type for your scanned image. (Default is
Front Color and Rear Color).

5.

Click OK to quit the Scanner Properties dialog box.

6.

Place your document top edge first, and face up in the auto document feeder.
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7.

In the Scan Validation dialog box, click the Scan button (

) or choose Scan from the File menu.

8.

The document will be scanned and displayed in the Scan Validation screen.

9.

You can view the scanned image Fit to Page (

) or in Actual Size (100%) (

).

10. Click the Close box or Quit from the File menu to exit the Scan Validation Tool.
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2. Using the Scanner Properties Dialog Box (Setup)
In this chapter we provide an overview of the Scanner Properties dialog box (Setup).
The Scanner Properties dialog box allows you to configure the scanner’s settings. It consists of several
tabbed windows each of which will be described in this chapter.
Important: the Scanner Properties Dialog Box in the Capture Tool is the same as the one that appears
when you click scan in Readiris and IRISmart File/Invoice.

Note:
In this chapter, all options are described based on a duplex (double-side) scanner.

2.1 A Glance at the Scanner Properties Dialog Box
1

2

3
4
5
6
7

8

1. Tab Options

Choice: Image, Compression (PC), Color Dropout, Paper, Multi-feed Detection,
Preview (PC), Enhancement, Setting, Information.
2. Image
Choose your image type and the side of document you wish to scan. Options
Selection Box vary based on the type of scanner.
3. Brightness
Adjust the brightness level from –100 to +100.
4. Contrast
Adjust the contrast level from –100 to +100.
Determine the quality of the scanned image. The industry standard is 300 dpi.
5. Resolution
6. Invert
Reverse the color of your scanned image.
7. Scan Source Choice: Auto Document Feeder, Merge Two Sides into One Image
8. Defaults
Reset all values on the tabs to the factory default settings.
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2.2 Buttons on the Scanner Properties Dialog Box

The buttons on the Scanner Properties dialog box
Buttons

Description

Defaults

Click the Defaults button, the factory default settings will be
shown on each tab.

OK

After all the scan settings are satisfactory, click OK to save
and close the Scanner Properties.

Cancel

Click Cancel to exit the Scanner Properties without saving.

The following table shows the default settings：
Tab name
Image

Compression
Color Dropout
Paper

Multi-Feed
Detection
Preview
Setting

Default settings
Image：Front Color, Rear Color
Binarization：Dynamic Threshold
Resolution：300 dpi
Invert：Blank on White
Scan Source：Auto Document Feeder
Threshold：None
Brightness：None
Contrast：None
None
None
Cropping：Automatic
Orientation：Portrait
Unit：Inch
None
None
Enable Energy Saver: Enabled, 15 minutes after last
scan.
Enable Power Off: Enabled, 240 minutes after last scan.
Show Scanning Progress：Yes
5
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Show Warning Message：Yes
Save Settings after closing: Yes

2.3 Showing or Hiding Tabs
The Scanner Properties dialog box is displayed by default with four basic tabs - Image, Paper, Setting and
Information. To show more tabs, click the Scanner Properties icon to access more scan settings.
To show more tabs:
1.

Click the Scanner Properties icon (
) on the upper left corner, and choose Tab to show the available
tab names. The available tabs include Compression, Color Dropout, Multi-Feed Detection, Preview,
Rotation, Separation, Enhancement and Imprinter.

2.

Choose the tab you want to display. The selected tab will be shown with a check mark and then
displayed in the Scanner Properties dialog box.

3.

To access the settings, click the selected tab at the top of the Scanner Properties dialog box. The page
of the selected tab will be displayed.

To hide a tab window:
1.

Click the Scanner Properties icon (
available tab names.

) on the upper left corner, and choose Tabs to show the

2.

Choose the tab you want to hide. Then, the selected tab will be hidden in the Scanner Properties
dialog box.
Note: The Image, Paper, and Information tab cannot be hidden since they are preprogrammed to be
displayed by default.
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2.4 The Image Tab
The Image tab allows you to choose the front side and (or) the rear side of your document, the type of
image, and configure several basic scan settings. Note that except for the resolution, you can set
individual scan settings for the front side and the rear side. For example, all settings in the Image tab,
Compression tab and Color Dropout tab can be set individually for the front and the rear side. However,
the settings in the Paper tab, the Enhancement tab and the Settings tab have to be the same for the front
and rear side.

The Image tab dialog box
2.4.1 The Image Selection Box
The Image Selection box includes
the image type and document side
option. If you wish to scan both
the front side and the rear side of
your color document, you can
check both Front Color and Rear
Color at the same time. Note that
the options vary based on type of
scanner.

Example 1：Scanning a two-sided color document, both sides in color

Side/Image
Selection

Front

Rear
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Example 2：Scanning a two-sided color document, one in B&W, the other in color

Side/Image
Selection

Front

Rear

Image Type

Description

Color

Choose Color if you wish to scan a color
image for your original in color.

Gray

Choose Gray image if your original contains
actual shades of gray.

B&W

Choose B&W if your original contains only
text, pencil or ink sketch.

B&W

Gray

Color

Front/Rear Auto Color Detection:
Click to automatically detect and scan the front or the rear page of your color document in color image
mode. If your document is in color, the scanner will automatically scan the document into a color image.
If your document is non-color, you can choose the output to be either B&W or Gray from the Non-Color
Selection option. This option is useful when you have a mixture of color and non-color document.
Note: If you choose Front Rear Auto Color Detection, you can not specify the image mode of your rear
page and vice versa.
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Modes of Auto Color Detection:
If Front/Rear Auto Color Detection is selected, its modes will be displayed. Choice includes Normal, Ignore
Paper Color. For paper with background color such as invoices, choosing Ignore Paper Color will
automatically remove the background color and enhance the detection accuracy.

Normal

Ignore single
background color

Sensitivity of Auto Color Detection
If your documents contain primarily B&W text and a small amount of light or pale colors and you do not
wish them to be recognized as color image to save the file size, you can reduce the sensitivity value by
moving the bar to the left to let these images to be detected as B&W. The value ranges from 1 to 100. The
default is 37.

Original

Sensitivity: 1
(The image is recognized
as a color one)

Sensitivity: 100
(The image is recognized
as a black and white one)
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Same settings on both sides:
Click to apply same scan settings for both sides of your documents. After checking this option, any settings
you have changed will automatically applied to both the front side and the rear side. For example, if you
choose your ideal resolution to be 300 dpi, this will be applied both to the front side and rear side of your
document.
2.4.2 Other Image Options
Binarization This is the process of converting a grayscale or color image to a bi-tonal
image. There are several different methods of performing this conversion.
Options: Dynamic Threshold, Dynamic Threshold (AD), Fixed Processing,
Halftone 1~5, Error Diffusion.
Dynamic Threshold: Selecting Dynamic Threshold allows the scanner to
dynamically evaluate each document to determine the optimal threshold
value to produce the highest quality image. This is used to scan mixed
document containing faint text, shaded background, or color background
with a single setting. If Dynamic Threshold is selected, Threshold,
Brightness, and Contrast are not available.
Dynamic Threshold (AD): Selecting Dynamic Threshold (AD) to perform
the enhanced mode of the Dynamic Threshold feature. However, using this
mode may slow down your scanning speed.
Sensitivity of Dynamic Threshold
Occasionally your scanned image may contain small dots or speckles. To
remove these spots, increase the sensitivity value by moving the bar to the
right. The value ranges from 1 to 30. The default is 20.
Fixed Processing: Used for black-and-white and other high contrast
documents. A single level is set to determine the black-and-white
transition. The threshold is programmable over the entire density range.
Fixed Processing sets Contrast to 0. If Fixed Processing is selected,
Contrast is not available.
Halftone: In addition to the black and white display, Halftone can present a
somehow gray shade of image by using different size of dots. Halftone image
looks like the picture we have seen in the newspaper. Options include
Halftone 1, Halftone 2, Halftone 3, Halftone 4, Halftone 5.
Error Diffusion: Error Diffusion is a type of Halftone. Error Diffusion gives
good image texture and makes text in images more readable than Halftone.

Halftone Image

Error Diffusion Image
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Dynamic Threshold
Threshold

Dynamic Threshold (AD)

Used to convert a grayscale image to a bi-tonal image. The value ranges from 0
to 255. A low threshold value produces a lighter image, and can be used to
subdue backgrounds and subtle, unneeded information. A high threshold value
produces a darker image, and can be used to help pick up faint images.
Adjust the threshold setting by dragging the Threshold sliding bar to the left or
right to achieve the desired threshold setting.

200 dpi,
Threshold:50,
Brightness: 0

200 dpi,
Threshold:100,
Brightness: 0

Gray
Document Type: Choice: Normal, Photo, Document
Three options of document type are provided when you choose Gray as the image type for your scanned
document. Choice: Normal, Photo, Document.




Document: Choose Document if your original contains pure text or a mixture of text and graphic
since it is an optimal setting for regular business document. When using Document, only Threshold
can be adjusted.
Photo: Choose Photo if your original contains photo to reproduce your photo in vivid grayscale image.
When using Photo, no Threshold and Contrast can be adjusted.
Normal: When using Normal, Threshold, Brightness, and Contrast can be adjusted.

Threshold: The value ranges from 0 to 255. The default is 230. A low threshold value produces a lighter
image, and can be used to subdue backgrounds and subtle, unneeded information. A high threshold value
produces a darker image, and can be used to help pick up faint images. Adjust the threshold setting by
dragging the Threshold sliding bar to the left or right to achieve the desired threshold setting.

11
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Brightness
Contrast

Normal

Photo

Document
(Threshold: 230)

Normal

Photo

Document
(Threshold: 230)

Adjusts the lightness or darkness of an image. The higher the value, the
brighter the image. Drag the slider to the right or left to increase or
decrease the brightness. The range is from –100 to +100.
Adjusts the range between the darkest and the lightest shades in the image.
The higher the contrast, the bigger the different grayscale. Drag the slider
to the right or left to increase or decrease the contrast. The range is from
–100 to +100.

Brightness: -50

Brightness: 0
(Normal)

Contrast: -50

Contrast: 0
(Normal)

Brightness: +50

Contrast: +50
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Resolution

Selecting a good resolution results in a quality scan. The resolution is
measured in dots per inch (dpi). Normally, the greater the dpi number, the
higher the resolution and the image file size. Be aware that greater
resolution takes more time to scan, and more disk space for the scanning
image. For your information, an A4 size color image scanned at 300 dpi at
True Color mode consumes approximately 25 MB of disk space. A higher
resolution (usually means over 600 dpi) is only recommended when you
need to scan a small area at True Color mode.
Choose a resolution value from the drop down list. The default value is 300
dpi. Available resolutions are 75, 100, 150, 200, 300, 400 and 600. Or you
may choose your desired value by clicking the box in the right side of the
drop down list and press the arrow key to select your desired value and then
click the Add button to include it in the drop down list. Note: The resolution
is up to 300 dpi if an imprinter or a MICR reader is installed or connected to
the scanner.

Resolution: 75 dpi
Invert

Resolution: 150 dpi

Reverses the brightness and the colors in the image. The default setting is Black on
a White background. Reverse mode is White on a Black background. For color
images, each pixel will be changed into its complementary color at the command of
Invert.

Black on White
Scan
Source

White on black

Choice:
 Auto Document Feeder: Used to scan multiple pages.

Merge Two Sides into One Image:
With the sheet-fed duplex scanner with front input tray, you can scan an
A3 size document with an innovative method: fold your A3 size document
into A4, and then load the paper in the front tray. Choose Merge Two
Sides from the Scan Source option and then the scanner is able to scan
both sides of your document and merge two A4 images into one A3 image.
When you select Merge Two Sides into One Image, the Cropping or Multifeed function will be disabled.
If Merge Two Sides into One Image is selected, its choice will be available
including Merge Horizontally, Merge Vertically, Merge Vertically (Back Side
Flip). If the reverse side of your document is upside down, choose Merge
Vertically (Back Side Flip) and the back side will be automatically rotated
180 degrees and merged.
13
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Front
Side
Rear
Side

Front
Side

Rear
Side

Merge
Vertically

Merge
Horizontally
Note: This feature must be used with a carrier sheet (optional). Regarding
how to load a document with a Carrier Sheet, refer to Section 2.6.2, Other
Paper Selection.

Color
Matching

The purpose of Color Matching is getting the accurate color. This option
uses the default parameters (ICC profile) to adjust the colors of the
image.
Choice: None, Document, Photo


None: Choose None to disable this option.



Document: Choose Document if your original contains pure text
or a mixture of text and graphic since it is an optimal setting for
regular business document.



Photo: Choose Photo if your original contains photo to reproduce
your photo in vivid color image.

Normal

After Color Matching

2.4.3 Scanning color images
The following options are available for scanning color images.





Brightness
Contrast
Resolution
Invert

2.4.4 Scanning grayscale images
The following options are available for scanning gray images.





Brightness
Contrast
Resolution
Invert
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2.4.5 Scanning B&W images
The following options are available for scanning B&W images.




Binarization (Dynamic Threshold)
Resolution
Invert

Or






Binarization (Fix Processing)
Threshold
Brightness
Resolution
Invert

Editing Profiles
The Scanner Properties dialog box allows you to change and save your frequently used scan settings into a
profile. You can edit these profiles by renaming or deleting them.
To add a new profile,
1.
2.

Customize your settings. (For example, change your resolution, image type, cropping method, scan
size, or other scan settings.)
Click the Image tab and then choose Profiles to prompt the Edit Your Profile dialog box.

3.

Click Add to enter the name of the profile and then choose Save.

4.

The new profile will be saved and shown in the Profiles dropdown list box.
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To load a profile,
1.

From the Image tab dialog box, choose your favorable profile from the Profiles dropdown list box.

2.

Your favorable profile will be immediately loaded and displayed on Scanner Properties dialog box.

To delete a profile,
1.

From the Image tab dialog box, click Profiles to prompt the Edit Your Profile dialog box.

2.
3.
4.

Choose the profile you want to delete from the dropdown list box.
Click Delete. A Confirm message “Are you sure you want to delete this profile?” is prompted.
Choose Yes to delete or Cancel to quit.

To rename a profile,
1.

From the Image tab dialog box, click Profiles to prompt the Edit Your Profile dialog box.

2.

Choose the profile you want to rename from the dropdown list box and then click the Rename button.

3.

Enter new name for the profile.

4.

Choose Save to save the new profile or Cancel to quit.

Note (PC only):
The preset default profiles include Flatbed, Simplex-B&W, 200 dpi, Simplex-Gray, 200 dpi, Simplex-Color,
200 dpi, Duplex-B&W, 200 dpi, Duplex-Gray, 200 dpi, Duplex-Color, 200 dpi. If you have a simplex or a
sheetfed scanner, the duplex or the flatbed option will not be available.
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If any setting for a current profile has been changed, a [*] sign will be marked before the name of current
profile, for example, [* Duplex, Color, 200 dpi]. If desired, click the [OK] or [Scan] button and a dialog
box will be prompted to let you save the new profile

2.5 The Compression Tab (Windows PC only)
The Compression tab allows you to compress your scanned image and choose the level of compression. Bitonal images are normally compressed using CCITT standard called Group 4 (G4). Color and grayscale
images are often compressed using JPEG technology. Move the JPEG Quality slider to the right or left to
increase or decrease the level of compression. Note the greater the compression level, the lower image
quality. Default is 50%.
Note that the compression depends on your image editing application. If your image editing application
does not support the type of compression format, then either a warning message will appear or the image
quality of the compressed file will not be acceptable.
JPEG (Joint Photographic Editor Group). This group developed and lent their name to a file compression
standard for color and grayscale images that is widely used by scanners, and software applications. On
Microsoft Windows-based systems, a file with the extension .jpg has normally been compressed using this
standard.
For scanning color or gray images, the following compressions are available:

None

JPEG
For scanning B&W images, the following compressions are available:

None

G4

The Compression tab dialog box
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2.6 The Color Dropout Tab
2.6.1 Color Dropout Selection
The Color Dropout tab allows you to select either green, red, blue, or a color of your choice to remove the
details of the selected color from a scanned image. This feature is used to sharpen your text when using
OCR (Optical Character Recognition) software. Note this feature applies only to the gray or black and white
image.
Choice: None, Auto, Remove Red, Remove Green, Remove Blue, Custom.
- None: Does not remove any color.
- Auto: Automatically outputs the image with the details of the primary color removed.
- Remove Red/Remove Green/Remove Blue: Outputs the image with the details of the specified
color removed.
- Custom: Specify the color you wish to remove by entering its RGB (Red, Green, and Blue) value
respectively.
Advanced Options:
- Quality Mode: Range: 0~20. Default: 10
When Quality Mode is selected, you can determine the color to be dropped out using the Filter
Threshold slider. A lower value will drop more of the selected color out, while a higher value will leave
more of the selected color in.
- Normal Mode: Use an optimized setting to determine the color.

Original

Auto/Remove Green
(normal mode)

Remove Red (normal mode)

Remove Green (quality
mode: Threshold: 18)

Preview the color dropout result:
To preview the color dropout result, please follow these steps:
1. Click the Scanner Properties icon (
tab names.

) on the upper left corner, and choose Tab to show available

2. Choose Preview to show the Preview tab.
3. Click the Preview tab to show the Preview page.
4. Load your document to the scanner and click the Preview button to get a preview image.
5. On the Image tab, click Gray or Black and White image mode and then choose Custom on the Color
Dropout tab. A Preview window button will be displayed.
6. Click the Preview window button to prompt the Preview window with the previewed image.
7. Move your cursor over the preview image. Your mouse cursor now becomes an Eyedropper.
8. Click to select a color which you wish to remove.

18

User Guide – IRIScanTM Pro 5

9. Click and hold your mouse button to view the result after removing the specified color. If the result
is satisfactory, click OK to close the Preview window.

The Preview Window

The Color dropout result

The Color Dropout dialog box

19

User Guide – IRIScanTM Pro 5

To select a color on the Color palette,
1.

Click the Color
Dropout tab from the
Scanner Properties
dialog box.

2.

Choose Gray or B&W
from the Image
Selection box and
click Custom from the
Color Dropout dropdown menu. The
Color palette appears.

3.

Move your cursor
over the palette. The
cursor becomes a
cross sign.

4.

Click to choose a color. The RGB values are changed
simultaneously.
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2.7 The Paper Tab
The Paper tab allows you to define values relating to image output (i.e., Auto Crop or not, Scan Area,
OverScan, Multi-Feed Detection).

The Paper tab dialog box
2.7.1 Cropping
Cropping allows you to capture a portion of the document being scanned. Choice: Automatic,
Automatic (118), Fixed to Transport, EOP (End of Page) Detection, Relative to Documents.
Options

Description

Automatic

Automatic adjusts the cropping window according to different
document sizes and automatically straighten a skewed document. Use
this option for batches of mixed-sized documents.

Automatic
(118”)

Automatically adjusts the cropping window according to different
document sizes smaller than 118” and automatically straighten a
skewed image. Use this option for batches of mixed-sized document.

Fixed to
Transport

This feature allows you to define the area or zone to be imaged. Use
for batches of same-sized documents. If you select this option, you
can use the arrow keys to define the x and y offset values, width and
length to redefine your scanned area. The Display window will show
image placement as you change the values.

EOP (End of
Page)
Detection

This feature allows you to define the area or zone to be imaged. Use
for batches of same-width but different length documents. If you
select this option, you can use the arrow keys to define the x and y
offset values, width and length to redefine your scanned area. The
Display window will show image placement as you change the values.

Relative to
Document

This option allows you to crop different areas on your documents and
deliver these images in B&W, Gray, or Color separately. For example,
there are applications which require you to store the entire document
in B&W and a part of the document in color to save storage space.
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This is useful for documents where a photograph or signature appears
in a consistent area on the document such as resumes, and so on.

The following options are only available when Fixed to Transport is selected.


X-Offset — the distance from the left end of the scanner to the left edge of the scanning area.



Y-Offset — the position from the top end of the document to the top end of the scanning area.



Width — the width of the scanning area.



Length — the length of the scanning area.



Center — automatically calculates the x-offset for center-fed feeding based upon document size
selected.



— relocate the scan area by click the arrow key on the cross sign while retain the scan size.
View the result from the Display window.

The Adjustment option is available when Automatic is selected.


Adjustment —adds a positive/negative margin value Top/Bottom or toward left/right of the image.
Adjustment is used when the automatic document feeder is used. Adjustment reduces the possibility of
corner clipping on skewed images. To set Adjustment values, use the UP/Down buttons to select where
you want to apply Adjustment values: Top/Bottom or Left/Right, and then select the amount of
inches/mm/pixels applied. Select a value within the range of 0.00 to 1.00 / -1.00.

Relative to Document: (used for batches of same-sized documents)
This option allows you to crop different areas on your documents and deliver these images in B&W, Gray,
or Color separately. For example, there are applications which require you to store the entire document in
B&W and a part of the document in color to save storage space. This is useful for documents where a
photograph or signature appears in a consistent area on the document such as resumes, and so on.
The following procedure describes how to reproduce the entire document in B&W and a portion of
document (picture) in color.
1.

On the Paper tab, choose Relative to Document or Fixed to Transport from the Cropping option.

2.

Choose your scan size from the Scan Area option. The selected scan size will be displayed in a red
rectangular box. This is also the scan size of your entire document. (For example, ISO B5. If you
have not chosen a scan area and leave the selection as None, then the default area will be the
scanner’s maximum.)

A red
rectangular
box
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3.

Click the Preview tab to display the Preview window. A black rectangular box appears to indicate the
max. scan size your have just selected.

The Image Selection
Box

4.

A black
rectangular
box

Click the Preview button to view the entire image in low resolution to correctly crop your relative scan
area.

The Preview
Image

The Preview
Button
5.

Select image type from the Image Selection box. The selected image will appear in highlighted color.
(For example, Front Color)

6.

Place your cursor on the Preview window and click your left mouse button. A cross sign will appear as
illustrated. Create your relative scan size diagonally by dragging the left mouse button to your
preferable size. The selected area will appear in a red box as illustrated.

A Cross
Sign

7.
8.

The
Relative
Area

Check the B&W image from the Image Selection box to scan the entire document.
Click the Scan button to start scanning the document in two image types and sizes. (See the result
below.)
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The entire document in B&W

The relative area in color

2.7.2 Other Paper Selection
Note that a Carrier Sheet is not delivered with the IRIScan Pro 5.
Carrier Sheet Mode:
Check this option to automatically crop the scan window according to your document size when scanning
non-standard document (fragile, irregular-size document) with a carrier sheet (optional).
Loading Documents Using a Carrier Sheet
A Carrier Sheet is a plastic sheet specifically used for loading non-standard document onto the scanner. It
allows you to scan document that can not be scanned in the regular way. Also, documents larger than A4
size, such as A3 and B4, can be scanned by folding in half, inserting into the Carrier Sheet, and scanning in
duplex mode. You can also scan documents that can be damaged quite easily such as photographs, or
irregular size documents that are difficult to load directly such as clippings.
To scan document using a Carrier Sheet,
For documents larger than A4/Letter size, such as A3
a. Fold the sheet to be scanned in half.
b. Fold the sheet tightly and smooth out crease. Otherwise, the sheet may be skewed during scanning.

1.

Open the Carrier Sheet and place the document inside.
Align the top of the document to the top of the Carrier Sheet (the printed area).
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For documents larger than A4/letter size, such as A3
Align the top of the document to the top of the Carrier Sheet (the printed section) and the folded
portion to the right edge of the Carrier Sheet so that the document fits into the Carrier Sheet at the
upper corner.

For non-standard document
Center your document in the Carrier Sheet.

2.

Load the Carrier Sheet with the gray section (printed section) facing downwards.

3.

Adjust the paper guides to the width of the Carrier Sheet.
Adjust the paper guides so that there is no space between the guides and the Carrier sheet. Space
between the guides and Carrier Sheet may cause the Carrier Sheet to become unaligned during
scanning, and skew the scanned image.

4.

Start the scan.

Notice:
 Carrier Sheet is available for the models that support the Carrier Sheet.
 Some functions are disabled when Carrier Sheet is checked.
 This option may not work properly on some applications.
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Scan Area
Choose your desired paper size with the drop-down list box. Or you may select a custom paper size by
clicking the Scan Area box and then click Add to include in the choice.
None
US Letter
US Legal
ISO A4
ISO A5
ISO A6
ISO A7
ISO B5
ISO B6
ISO B7
JIS B5
JIS B6
JIS B7
Scanner Maximum
Long Page (<118)

8.5x 11
8.5 x 14
21 x 29.7 cm
14.8 x 21 cm
10.5 x 14.8cm
7.4 x 10/5 cm
17.6 x 25 cm
12.5 x 17.6
cm
8.8 x 12.5 cm
18.2 x 25.7
cm
12.8 x 18.2
cm
9.1 x 12.8 cm

Long Page (<118):
When you need to scan documents whose length exceeds scanner maximum, please choose Long Page.
Note if Long Page is selected, the Multi-Feed Detection will not be available.
Note: This option and the maximum allowable document length vary due to type of scanner.
Note: This option is not supported on Mac OS X. On Mac OS X a document cannot be longer than 14” when
Automatic (118”) crop is activated.
When Long Page (<118) is selected, be sure to specify your document size in the Length and Width field.
Notice when scanning a long page document:
1. Pull out the extension in the ADF Paper Tray.
2.

Secure enough space around the Output Tray to prevent the ejected paper from falling off the Output
Tray

3.

To ensure the performance, in color mode, set the resolution to be 300 dpi or lower; in Black and
White mode, set the resolution to be 600 dpi or lower.

4.

Depending on your system environments, application, or your specified paper size, there may be
insufficient memory to perform scanning.

OverScan
Overscan allows you to add a specific margin at top and bottom or right and left (Options vary based on the
type of scanner) of the edge of the image. This is used to reduce possible corner clipping on the skewed
images and often applied to a batch of skewed document to be scanned in the auto document feeder.
Select a value between 0 and +5 mm. Note the overscan result will not be shown in the Display window
and that the availability of the function varies based on type of scanner.
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Transport Timeout
Set the amount of time the scanner will wait and then start auto scan after the first scan job is completed.
If you have many separate documents need to be scanned at the same scan settings, this feature is
especially useful. The default is 0. The value ranges from 0 to 30 seconds.
Note:
1
Within the specified timeout period, if you load your document to the feeder, the scanner starts
scanning automatically.
2
If your scanner has a flatbed option and you place your paper on the flatbed, after the timeout
period, you need to click the Scan button on the TWAIN user interface to start scanning.

Background Setting
This option allows you to set your scan background. Choice: White Background, Black Background.
Note: For a sheet-fed scanner with an auto document feeder, this option is currently available only in the
Auto crop mode. For a scanner with a flatbed platen, this option is available either in the Auto crop or the
Fixed to Transport mode.

White Background

Black Background
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2.8 The Multi-Feed Detection Tab
Multi-Feed Detection
Multi-Feed Detection allows you to detect overlapped documents that go through the auto document
feeder. Multi-Feed usually occurs due to stapled documents, adhesives on documents, or electro-statically
charged document.

Additional Length Detection
Additional Length Detection allows you to define the length of document being multi-fed. This value
indicates the additional length exceeding your scan area. The Display window will show the size of the
document as you change the value. A value of 0 indicates no additional length detection. The Additional
Length Detection is best used when scanning same-size documents in the auto document feeder.
Ultrasonic Detection
Ultrasonic Detection allows you to set overlapped document by detecting paper thickness between
documents.
There are two options available if Multi-Feed is detected.




Stop Scanning after Multi-Feed


If this is selected, the scanner will stop the feeder and prompt a multi-feed warning message. In
addition, the multi-feed paper will be ejected from the scanner automatically.



If this is not selected, the scanner will continue scanning the entire document though multi-feed is
detected. After the entire document has been scanned, a multi-feed dialog box will be prompted
to indicate the page number which has been detected multi-feed and need to be rescanned.

Multi-Feed Alarm
If a wave file is added, the scanner will make a sound alarm if multi-feed is detected yet no Warning
dialog box will be displayed.
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How to add the sound alarm：
1. Click the Browse button on the right side of the speaker icon. The Open dialog box appears.
2. Choose your wave file.
3. Click the Open button. The wave file is added.
Units
Defines the primary measurement system. Inches, Millimeters, and Pixels are available.

2.9 The Preview Tab
The Preview tab allows you to preview (a low-resolution scan) your image before final scan. This preview
image lets you allocate your scan area. You can choose your scan area by the Scan Area drop down list
box or placing your cursor on the Display window and dragging it diagonally on the Display window. Then,
a red rectangle box will appear to indicate the selected area.
Note: If you choose Automatic Cropping on the Paper Tab, then to select a scan area on the Preview tab is
not allowed.

The Display
Window

The Preview Tab
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2.10 The Enhancement Tab
The Enhancement tab allows you to set following additional image processing settings.

The Option tab dialog box
Punch Hole Removal
You can remove punch holes from the output scanned image when scanning punched document.

Original

Output image

Punch holes can not be removed when:
 Resolution is set lower than 150dpi
 The hole is near the edge of the document
 The holes are not aligned along the edge of the document
 Punch Hole Removal is available only when Auto Crop is enabled. If either Fixed to Transport, EOP
(End of Page) Detection, Automatic Multiple, Relative to Documents is selected from the Cropping
option on the Paper tab, the Punch Hole Removal option will be disabled.
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Background Processing: The Background Processing option allows you to smooth background color or
remove it to make image clearer. The option is especially useful for documents with color forms such as
invoices.
Choices: None (default), Smooth, Removal
- None - no background processing will be performed (default)
- Smooth - produces images with a more uniform background color. This option improves image quality.
- Removal - identifies the background color and then removes it.
Sensitivity: Choice: 0, 1, 2, 3, 4. Default: 0
- The higher the value, the more background color will be kept.
Mode: Auto, Moiré
If Smooth is selected in the Background Processing option, then the choices for the Mode option includes
Auto, and Moiré.
- Auto - uses the factory preprogrammed mode to proceed background smoothing.
- Moiré – Remove the moiré patterns that appear on the background of the image when scanning
printed material.
If Removal is selected in the Background Processing option, then the Mode option will be replaced with Fill
Color. Choices: White, Auto.
- White - identifies the background color and substitutes it with white.
- Auto - identifies the background color and substitutes it with the color of the largest background zone.

Background Processing: None

Background Processing:
Smooth

Background Processing:
Removal
Fill Color: White

Note: Background color in small zone will not be processed or removed.
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Edge Fille
Check White or Black if you wish to add white or black edge on the border of your scanned image. Enter
the value from 0 to 5 mm. Default value is 0.

Original

Edge Fill: 5mm (Black)

Despeckle
Occasionally small dots or specks appear in the background of a scanned image. Remove unwanted
speckles provides a cleaner image for OCR (Optical Character Recognition) processing, and also helps to
reduce compressed file size.
Define the speckles (also known as image noise) you wish to remove by specifying its number (size) and
radius (range). The measuring unit is pixel. The higher the number, the more speckles will be removed.

Before Despeckle
(noise number:0, noise radius:1)

After Despeckle
(noise number:22, noise radius:10)
Note :



This function is currently available for Black and White image only.
To scan at rated speed it is recommended to set the noise radius up to 10 pixels.

Line Removal: When Black and White image mode is selected on the [Image] tab, the [Line Removal]
option will be enabled. Line Removal erases lines on the image and then reconstructs characters so the
OCR (Optical Character Recognition) accuracy can be improved.
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Choices: None, Form, Horizontal, Vertical
None – the default mode which does not remove any line.
Form – remove any form in the document.
Horizontal – select Horizontal and then enter the length of horizontal line to remove only the horizontal
line exceeding your specified length.
Vertical – select Vertical and then enter the length of vertical line to remove only the vertical line
exceeding your specified length.

None

Remove Form

Remove Horizontal Line
(over 30 mm)

Remove Vertical Line
(over 70 mm)

2.11 The Rotation Tab
The Rotation tab allows you to set the following image rotating options:
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Rotate Image
Choose the rotation angle from the drop down list if you wish to rotate your scanned image.
Choice: None, 90°CW(clockwise), 90°CCW(counter clockwise), 180°, Auto based on contents. Auto rotate
every even page.

Original

Rotate 90°CCW

Rotate 90°CW

Rotate 180°

Auto based on contents: Automatically rotate images based on the contents of document. When Auto
based on contents is selected, its modes will be enabled to let you select more options.
Mode: Quick, Full Text, Complexity
Quick – the default mode to let you rotate images at the fastest speed.
Full Text – the enhanced mode for documents with mixed text orientation.
Complexity – the enhanced mode yet at the slowest speed for document with complex image or text
orientation.
Split Image
By splitting an image, two separate images are created horizontally or vertically. This is useful for
documents containing two pages per image when you want to save them as two images (one page for one
image). Choice: None, Horizontal, Vertical. Default is None.
Horizontal: Divide one image into the upper half and the lower half.
Vertical: Divide one image into the left half and the right half.

Split Horizontally

Split Vertical

Flip Side Rotation
Select fanfold to rotate the image of the reverse side to 180 degrees.
This is applied to double-sided document which are viewed in portrait are sometime fed into the scanner in
landscape or vice versa.
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Choice: Book, Fanfold.
If Book is selected, the image of the reverse side will not be rotated.
The following illustration shows the documents which should be viewed in portrait are fed into the scanner
in landscape.

Image Control Option
Check the Mirror box if you wish to reverse the right and left side of your image.

Original

Mirror Effect

2.12 The Separation Tab
The Separation tab allows you to enable the detection engine to detect the blank page, barcode, and patch
code and then notify the software application which supports document separation to separate your multipage documents. Choices: Blank Page Removal, Barcode Detection, Patch Code Detection.

Blank Page Removal
Choices: None, Blank Page Removal Threshold, Image Size.
None – Do not remove the blank pages.
Threshold - Move the slider to the left or right to define your threshold for the blank page.
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Image Size – Range: 1~ 10000 KB. Specify your desired image size to detect the page as a blank page.
For example, if 3 KB is selected, any page less than 3 KB will be recognized as blank page.
When the bar code has been detected successfully，a file [avbarcode.ini] will be created and stored in the
following path: C:\ProgramData\%PRODUCTNAME%
Barcode Detection:
Check Enable to detect barcode and notify the software application for advanced processing. Please note
the whole document will be checked and no specific detection area needs to be designated.
Barcode Types:
The following barcode types can be detected.
Two-dimensional codes
 Aztec
 DataMatrix
 PDF417
 QR Code
One-dimensional barcodes:
 Add-2
 Add-5
 Airline 2 of 5
 Australian Post 4-State Code
 BCD Matrix
 Codabar
 Code 128 (A,B,C)
 Code 2 of 5
 Code 32
 Code 39
 Code 39 Extended
 Code 93
 Code 93 Extended
 DataLogic 2 of 5
 EAN 128 (GS1, UCC)
 EAN-13
 EAN-8
 GS1 DataBar
 Industrial 2 of 5
 Intelligent Mail (One Code)
 Interleaved 2 of 5
 Inverted 2 of 5
 ITF-14 / SCC-14
 Matrix 2 of 5
 Patch Codes
 PostNet
 Royal Mail (RM4SCC)
 UCC 128
 UPC-A
 UPC-E
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Barcode Zone:
Specify the barcode zone to be detected.
Select All to checks the whole document and detects barcodes. Or you may speed up the process by
specifying a detection area since only the specified area is checked.
Choice: All, Top, Bottom, Left, Right, Bottom Right, Bottom Left, Top Right, Top Left.
Choice for barcode zone on a page:

All

Top

Bottom

Left

Bottom
Right

Bottom
Left

Top Right

Top Left

Right

Note:
 Recommended resolution: 200~600 dpi for regular barcode, 300~600 dpi for QR code.
 Skewed barcodes may not be recognized correctly.
 Using the same sheet repeatedly may decrease the recognition accuracy due to accumulated dirt on
the sheets. If the sheet is not recognized correctly or gets smudged, replace it with a new sheet.

2.13 The Setting Tab
The Setting tab allows you to set the following settings:

The Setting tab dialog box
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Cache

Mode: None, Page Number, Memory Size.
This option allows you to assign a specified memory size from the available
RAM to process the image data. By specifying a smaller memory size, you can
free more memory for other applications you are running. By specifying a
larger memory size, you can have more memory to process the image data
especially when you have a large amount of documents needed to be scanned.
You can also specify your memory size by the page number. For your
information, an A4 color document scanning at 300 dpi consumes
approximates 24MB.
Image Count
When the selected cache mode is none, the image count option allows you to
assign number of pages you need to scan. For example, if you wish to scan the
first two pages, simply move the page slider to 2, and the scan action will be
stopped when the scanning of the first two pages have been completed.

Enable
Energy
Saver

Check the Enable Energy Saver box and move the slider to set the amount of
time to start the energy saver after your last action. The range is from 1 to
240 minutes. The default value is 15 minutes.

Enable
Power Off

Check the Enable Power Off box and move the slider to set the amount of time
to automatically turn off the scanner after your last action. The range is from 1
to 480 minutes. The default is 240 minutes (4 hours). Note the value of Power
Off has to be greater than or equal to the value of Energy Saving.

Show
Scanning
Progress
Show
Warning
Message

When selected, the scanning progress bar will be shown during scanning.

Eject Paper
Opposite

Check if you want the scanned document to exit from the opposite tray.

Check to show the warning messages such as ADF pad count exceeds 50,000
scans (the number varies based on the type of scanner). Please replace the
ADF pad and reset the pad count.
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2.14 The Imprinter Tab
The Imprinter tab allows you to print alphanumeric characters, date, time, document count and custom
message on your scanned image if digital imprinter is selected or at the back of your document if external
imprinter is selected.

Choice: External Imprinter, Digital Imprinter. If you have installed an external imprinter, choose
external imprinter. If you do not have an imprinter, choose digital imprinter. Note External Imprinter
provides a vertical and rear-side print capability while digital printer provides a horizontal and front-side
print capability.
Contents
Print All
Custom
Counter

Date/Time

Custom
Font

Check Print All to automatically print the text at all pages of your documents.
Uncheck Print All to print the text for the first page of your documents only.
Enter your custom text to be included in your print string.
Show the document count for the scan session. This value is increased
sequentially by the scanner.
Choose if you wish to include the date and time in your print string.
Format: YYYYMMDDHHSS For example, 20090402170645-check0001 indicates
year, month, date, hour, seconds, your custom text and the counter.
Choose your desired font.
Choice: Normal, Fixed Width
Fixed Width (Mono spaced) fonts have a fixed character spacing. So each
character occupies the same width.

Advanced
Font
Attributes

Choose your font attributes. Choice: Normal, Underline, Double, and Bold.

String
Orientation

Choose your string orientation.
Choice: Normal, Rotated, Vertical, Vertical Inversion, 90 degrees CW, 90
degrees CCW
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Normal

Rotated

Vertical

Vertical Inversion

90 degrees CW

90 degrees CCW

If you check the digital imprinter to stamp text on your scanned image, the
illustration of normal and rotated string is shown below:

Normal

Print
Position

Rotated

Choose the position you wish to print your string. Move the slider to the right
to increase the value or to the left to decrease the value. Range: 0~355mm,
default: 0 mm
The value indicates the height from the bottom of your paper to the last letter
of your string. This option is available only if an external imprinter is installed.

The value of
Print Position

Print Position (for digital imprinter)
Choose the position of your printed string. Choice: Top, Middle, Bottom, Custom. If Custom is selected,
enter the X and Y offset value to specify the position.
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2.15 The Information Tab
The Information tab displays the following system and scanner information.

The Information tab dialog box

The following options are PC only:
The Report button：
If you encounter any error message while using the scanner, click the Report button. A report.txt file
C:\ProgramData\%PRODUCTNAME%) will be generated. Please send this file to the nearest service center
for trouble shooting.
The Reset Roller Count button：
After scanning approximately 200,000 pages (the number varies based on the type of scanner) through the
ADF, the ADF roller and ADF pad may be worn out and you may experience problems with document
feeding. In this case, it is highly recommended to replace the ADF roller and pad with a new one. After
replacing the ADF roller and ADF pad, click the Reset Pad Count and Reset Roller Count buttons to reset
the counts.
Note：
The lifetime and the replacing procedure vary based on the type of scanner.
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3. Legal Information
Trademarks
Microsoft is a U.S. registered trademark of Microsoft Corporation.
Windows, Windows Vista, Windows 7, Windows 8 and Windows 10 are either registered trademarks or
trademarks of Microsoft Corporation in the United States and/or other countries.
IBM, IBM PC are registered trademarks of International Business Machines Corp.
Other brands and product names herein are trademarks or registered trademarks of their respective holders.

Copyright
IRIScanPro5-dgi-06022017-01

Copyright© 2017 I.R.I.S SA. All rights reserved.
Information in this document is subject to change without notice. The software described in this document
is furnished under a license agreement or nondisclosure agreement. The software may be used or copied
only in accordance with the terms of those agreements. No part of this publication can be reproduced in any
form or by any means without prior written permission of I.R.I.S. SA.
Material scanned by this product may be protected by governmental laws and other regulations, such as
copyright laws. The customer is solely responsible for complying with all such laws and regulations.

Warranty
The information contained in this document is subject to change without notice.
I.R.I.S. makes no warranty of any kind with regard to this material, including, but not limited to, the
implied warranties of fitness for a particular purpose.
I.R.I.S. shall not be liable for errors contained herein or for incidental or consequential damages in
connection with the furnishing, performance, or use of this material.

